
 

 

COMPUTER 

APPLICATIONS 

OLYMPIAD 
 

ROUND 2 
 

2017 
 

POSSIBLE 

SOLUTIONS 
 

Contributors 

Dr Pam Miller; Charles Smith; Peter Davidson; Mike Chiles 



 

 

 
 

2 

Some of the solutions presented in this booklet use techniques that are not included in the current CAT 

curriculum. They are presented here as alternative methods for solving the problems. It is hoped that 

teachers and participants (learners) will look at the methods used and consider using them in their Practical 

Assessment Tasks which, in a sense, are open-ended and where use can be made of techniques not 

included in the curriculum (see Assessment Criteria 6 and 10 of the DBE’s 2017 PAT for Grade 12). 

Some of the solutions presented might be considered inefficient or not so elegant. The main purpose in 

providing a variety of different solutions to most of the questions is really to show that there is normally 

more than one way to solve a particular problem. Refinements can be made, especially in the database 

questions, to make the output look neater – this is left to the reader to consider. 

There are probably also a number of other ways of solving the problems. Readers are encouraged to 

suggest other solutions and to send them to the Olympiad office. 

To find out more about how to use pivot table in Excel and Access refer to the following: 

- Excel: https://exceljet.net/excel-pivot-tables 

- Access: https://support.office.com/en-us/article/Create-PivotTable-or-PivotChart-views-in-an-

Access-desktop-database-83e524df-dfbd-456d-9dd0-0a48c1aa6752  

A: WORD-PROCESSING 

Over the years, there have been numerous studies to show how playing different types of background 

music can influence shopping behaviour. Everything from music volume to tempo can all play a part in how 

consumers spend money and behave in shops. The document file 'Music in Retail Stores' discusses 

some of the issues that owners need to consider. Use word processing features to answer the following 

questions.  

 

1. What percentage style shading is used in the top row of the table?  Give the 

number only, e.g. 17 or 93 
10 

Highlight the top row of the table, then right click and select “Table Properties” from the drop-down 

menu. 

 
 

Then select “Borders and Shading” in the “Table Properties” dialog box. In the “Borders and Shading” 

dialog box that opens click on the “Shading” tab. 

https://exceljet.net/excel-pivot-tables
https://support.office.com/en-us/article/Create-PivotTable-or-PivotChart-views-in-an-Access-desktop-database-83e524df-dfbd-456d-9dd0-0a48c1aa6752
https://support.office.com/en-us/article/Create-PivotTable-or-PivotChart-views-in-an-Access-desktop-database-83e524df-dfbd-456d-9dd0-0a48c1aa6752
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The “Style” property shows that the shading is set at 10% 

 

2. What is the exact height (in cm) of the image near the heading 'Four key 

elements of effective retail music'? Give the number only, e.g. 27. 
5 

Method 1: 

Select the picture. Under “Picture Tools” in the ribbon make sure that “Format” is selected. In the “Size” 

group on the right of the ribbon you’ll notice the height and width of the image. 

 

 
 

Method 2: 

Right click on the picture and select “Size and Position” from the drop-down menu. The height is 

indicated. 
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3. What word is at the beginning of the 50th line of the whole document? Give the 

word exactly as it is in the text. You may copy and paste, e.g. Music 
Beat 

The line numbers will be partially hidden behind the page border so it would be best to first switch off 

the page border. Click on “Page Borders” in the “Page Background” group in the “Page Layout” 

(2010)/”Design” (2016) tab on the ribbon. Selecting “None” in the “Borders and Shading” dialog box will 

cause the page border to be switched off. 

 

Having switched off the page border in the “Page Setup” group in the “Page Layout” (2010)/”Layout” 

(2016) tab on the ribbon select the arrow next to “Line Numbers”. In the drop-down menu select 

“Continuous” as this setting will ensure that the lines are numbered continuously and don’t start at 1 on 

each new page. Scroll down the page until you get to Line 50. 

 
The first word on line 50 is the word “Beat” 
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B: SPREADSHEET 

The Billboard Hot 100 is a chart that ranks the best-performing songs of the United States in any given 

year. Its data, published by Billboard magazine and compiled by Nielsen SoundScan, is based collectively 

on each song's weekly physical and digital sales, as well as airplay and streaming. The database 'Hot100' 

contains some details of all the songs for the period 2001-2012. In the questions below a “solo performing 

artist” is an artist who performs by themselves and so only their name appears in the database as the artist. 

The spreadsheet file called 'BBHot100HitsR2' contains information on the songs which made it into the 

Billboard Hot 100 hits between 2001 and 2016. 

Many of the questions below can best be answered by turning on the filter in the “Sort & Filter” group under 

the Data tab in the ribbon. Note also that the data starts in Row 2 and ends in Row 1601. 

Wikipedia defines dirty data as “data that is inaccurate, incomplete or erroneous, especially in a computer 

system or database”. It is often necessary when processing data to first “clean” the data. For example, when 

entering data the data-capturer could accidentally insert a double space between the name and surname of a 

person.  

 

1. How many songs do not have a value for the length of the song? Give the 

number only e.g. 131 
492 

Songs that do not have a length will be those where the cells in the column headed “Length” are empty 

(or blank). 

Method 1: 

With the filters switched on click on the arrowhead next to the column headed “Length”, deselect “(Select 

All)”, scroll down and select “(Blanks)”. The data will be filtered and only those 492 rows where the cells 

in the column headed “Length” that are blank (empty) will be displayed. 

 

Remember when finished to clear the filter from “Length”. 

Method 2: 

Use the COUNTBLANK-function to count the number of cells in the column that are empty (blank). Enter 

the following formula in a cell, say F1603:  

=COUNTBLANK(F2:F1601) 

When executed the answer 492 will be displayed in the cell. 

Method 3 

Use the COUNTA-function to determine how many cells in the column have a value and then subtract 

that from 1600 (the total number of songs in the spreadsheet) – this will give the number of cells that are 

blank (empty). Enter the following formula in a cell, say F1603:  

=1600 - COUNTA(F2:F1601) 

When executed the answer 492 will be displayed in the cell. 

https://en.wikipedia.org/wiki/Data_cleansing
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Method 4 

Sort the list of songs according to their “Length”. Those songs with no given length will be grouped 

together, probably at the end of the list of songs. Highlight the code for these songs (column A) and then 

check the count in the taskbar: 

 

2. What is the title of the song which contains both 'cat' and 'dog' in the name of 

the artist(s)? Give the title of the song exactly like in the spreadsheet. You may 

copy and paste. 

Buttons 

With the filters switched on click on the arrowhead next to the column headed “Artist” and select “Text 

Filters” and then “Contains”. The following dialog box opens: 

 

In the first set of criteria enter the word “cat”. Make sure that “And” is selected as the title must contain 

both words. In the drop-down in the second set of criteria select “contains” and enter the word “dog”. The 

dialog box should then look as follows: 

 

If you then click on “OK”, the following is displayed. Note that in the cell under “Artist” both the word “cat” 

(Pussycat) and “dog” (Snoop Dogg) appear and that the “Title” of the song is “Buttons”. 

 

Artist Title 

The Pussycat Dolls featuring Snoop Dogg Buttons 

Remember to clear the filter from “Artist” before proceeding. 
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3. How many songs contain 'Lil Wayne' in the artist field? Give the number only, 

e.g. 131 
30 

The question requires that we search for “Lil Wayne”. However, we are not sure whether there is a 

single or double space between the two words and so it would be best to search for both words 

separately, i.e. “Lil” and “Wayne”, rather than searching for “Lil Wayne”. 

With the filters switched on click on the arrowhead next to the column headed “Artist” and select “Text 

Filters” and then “Contains”. The following dialog box opens: 

 
In the first set of criteria enter the word “Lil”. Make sure that “And” is selected as the title must contain 

both words. In the drop-down in the second set of criteria select “contains” and enter the word “Wayne”. 

The dialog box should then look as follows: 

  

If one had searched for “Lil Wayne” the result would have been 29 as there is one occurrence in the list 

where the two words are separated by a double space. 

Remember to clear the filter from “Artist” before proceeding. 

4. How many songs have the same number for the track and hit number? Give 

the number of songs only, e.g. 131 
10 

Method 1: 

It might be easiest to use another column in order to get to the answer. In this instance column J is being 

used. 

In cell J2 enter the formula below which tests whether the hit number (column C) is the same as the 

track number (column G). Copy this formula down to the other cells in the column. You should end up 

with a column of TRUE and FALSE values. 

=(C2 = G2) 

Then use the COUNTIF-function to count the number of times the value TRUE occurs in the column. In 

cell J1603 enter the following formula: 

=COUNTIF(J2:J1601, TRUE) 

The answer 10 will be displayed. 
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5. On which date (ddmm) were the most Billboard Hot 100 hits played?  If more 

than one date, give the most recent date. Give the date in the exact format 

specified, e.g. 3 August would be 0308 

2912 

Most of the methods used will work better if the songs are sorted in order of “Date Last Played”, from 

latest date to oldest date. 

Method 1: 

Highlight column H (Date Last Played) by clicking on the letter “H” at the top of the column. Then click on 

“Subtotal” in the “Outline” group in the “Data” tab. The following “Subtotal” dialog box opens: 

 
Click on the drop-down in the “Use function” field and select “Count”. Accept all other options and click 

on “OK”. You will note a number of things happen to the data: 

- The data is divided into groups and after each group a value indicating how many songs are in 

the group is given. For example: 

 

 
 

- On the extreme left of the worksheet a number of lines appear indicating how the dates are 

grouped. At the top of these lines you will note the numbers 1, 2 and 3 in boxes. These numbers 

allow you to quickly collapse the various groups. 

 

 
Now click on the number 2. The data collapses and one is left with the following: 
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What has happened here is that only the subtotals are displayed along with the date on which the songs 

were last played. In the above you will note that on 31 December 2016 twenty (20) of the songs were 

played. If you scan the list of numbers in the column headed “Date Last Played” you will note that 28 is 

the largest number and that this number of songs was played on 29 December 2016. 

The answer therefore is 2912, being 29 December. 

If you now click on the number 28 and then click on “Show Details” in the “Outline” group all the details 

for the songs played will be displayed. 

Method 2: 

To make the next solution slightly easier, copy the values in cells H1:H1601 to cell A1 in a new 

worksheet. Then highlight all the cells by clicking on the letter “A” and click on “Pivot Table” in the 

“Table” group on the “Insert” tab in the ribbon. A “Create Pivot Table” dialog box similar to that shown 

below opens up. In the dialog box make sure that the correct data is selected in the “Table/Range” field,  

select “Existing Worksheet” and in the “Location” field enter a cell, e.g. G2, and then click “OK”.. 

 

A “Pivot Table Field List” dialog box opens. Now click on the “Date Last Played” field in the field list and 

drag it into the “Row Labels” box. Also drag it into the “Values” box. Note that when you drag it into the 

“Values” box the COUNT function is automatically added. 

You should then have a “Pivot Table Field List” dialog box similar to that shown on the next page: 
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Whilst you’ve been doing the above a table similar to that shown below has been created with upper left 

corner in cell G2 (the table will display slightly differently in Excel 2016). 

Row 

Labels 

Count of Date Last 

Played 

2016/05/12 1 

2016/05/17 1 

2016/05/18 1 

2016/05/22 1 

2016/05/26 1 

2016/05/27 3 

2016/05/28 1 

2016/05/29 1 

2016/05/30 1 

2016/05/31 1 

Click on any value in the column headed “Count of Date Last Played” and then sort using the “Sort” (Z to 

A) option in the “Sort & Filter” group in the “Data” tab on the ribbon. The value in the pivot table will then 

be sorted from largest to smallest (as seen below). 

Row 

Labels 

Count of Date Last 

Played 

2016/12/29 28 

2016/12/31 20 

2016/12/23 19 

2016/12/28 19 

2016/12/30 19 

2016/11/15 19 

2016/09/11 18 

You will note that the date on which the largest number of songs was played is 29 December. 

Method 3: 

Copy the values in the “Date Last Played” column to TWO columns in a new worksheet (say columns A 
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and B). Highlight the second column (say column B) and click on “Remove Duplicates” in the “Data 

Tools” group under “Data” on the ribbon. If you’ve included the column heading you should get a 

“Remove Duplicates” dialog box similar to that shown below: 

 

Accept the suggestions by clicking on “OK”. The list of 1600 dates is collapsed into a shorter list 

containing 22 unique values. Now use the COUNTIF-function to determine how many dates in column A 

are the same as each of the values in the collapsed column B. The formula using the COUNTIF-function 

in cell C2 will look something like the following:  

=COUNTIF($A$2:$A$1601, "="&B2) 

Copying this formula down to the other cells in column C will give you something similar to the following: 

Date Last Played 

 2016/12/31 20 

2016/12/30 19 

2016/12/29 28 

2016/12/28 19 

2016/12/27 16 

2016/12/26 16 

2016/12/25 7 

Click on any cell in column C and then sort using the “Sort” (Z to A) option in the “Sort & Filter” group in 

the “Data” tab on the ribbon. The value in the table will then be sorted from largest to smallest (as seen 

below). 

Date Last Played 

 2016/12/29 28 

2016/12/31 20 

2016/12/30 19 

2016/12/28 19 

2016/12/23 19 

2016/11/15 19 

2016/12/19 18 

Once again you will note that the highest number of songs (28) was played on 29 December. 

Method 4: 

Sort the data on the “Date Last Played” column and the physically count the number of times each date 

appears. 
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6. What is the 'hash' total for the number 1 song of 2015? 

To create a 'hash' total, use column I, and together the following four values: 

- the value in the year field (column B) 

- the value in the no field (column C) 

- the length of the artist field (column D) 

- the length of the title field (include all characters) (column E). 

For example the song 'Most Girls' by 'Pink' which was number 97 in 2001 has a 

hash total of 2112. Do not delete this column (I) or your working in this column. 

Give the number only e.g. 2112. 

2059 

Using the filters, identify the number 1 song (column C) in 2015 (column B). You should get the following 

(row 1501): 

Year No Artist Title 

2015 1 Mark Ronson featuring Bruno Mars Uptown Funk 

In cell I1501 use a formula that makes use of the LEN-function, something similar to the following: 

=B1501 + C1501 + LEN(E1501) + LEN(D1501) 

This will combine the values indicated in the question and give an answer of 2059. 

7. How many titles by the same artist(s) appear in the Billboard Hot 100 hits in two 

consecutive years? Give the number only, e.g. 131 
138 

The solution focuses on titles by the same artist. In other words we first need to check whether the same 

title appears in consecutive years and then check that where this does happen whether the artist(s) is 

the same. It is possible for the same title to reach the Hot 100 hits but it could be performed by different 

artists. 

The solution to this problem will require the use of a number of additional columns to be used as 

“building blocks”. 

Method 1: 

Sort the dataset in ascending order according to Artist, then Title and then Year. This should place 

songs with the same title in alphabetical order one below the other. Where a particular title is sung by 

more than one artist the artists should be placed in alphabetical order one below the other next to the 

correctly ordered song title. Where a particular artist appears more than once then the years in which 

they appear should be in ascending order. 

For example: 

 B C D E 

 Year No Artist Title 

3 2009 87 Britney Spears 3 

4 2010 69 Britney Spears 3 

5 2013 71 Taylor Swift 22 

One can now read through the list noting where the title/artist combination occurs in consecutive years. 

For a list of 1 600 titles this is quite time-consuming. 
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Method 2: 

Sort the dataset in ascending order according to Artist, then Title and then Year. This should place 

songs with the same title in alphabetical order one below the other. Where a particular title is sung by 

more than one artist the artists should be placed in alphabetical order one below the other next to the 

correctly ordered song title. Where a particular artist appears more than once then the years in which 

they appear should be in ascending order. 

For example: 

 B C D E 

 Year No Artist Title 

3 2009 87 Britney Spears 3 

4 2010 69 Britney Spears 3 

5 2013 71 Taylor Swift 22 

The next step will be to check whether consecutive titles and artists are the same and whether the 

difference between the two years is 1. 

The following method makes use of empty columns to the right of the data, say columns J, K, L and M. 

Enter the following formula in cell J4: 

=(E4 = E3) 

The above formula tests whether the title in cell E4 is the same as the title in cell E3. If the titles are the 

same the value in cell J4 will be TRUE otherwise it will be FALSE. Copy this formula down to all other 

cells in column J. 

In the example given above the value in cell J4 will be TRUE as the titles are the same. The value in cell 

J5 will be FALSE as the titles differ. 

Enter the following formula in cell K4: 

=(D4 = D3) 

The above formula tests whether the artist in cell D4 is the same as the artist in cell D3. If the artists are 

the same the value in cell K4 will be TRUE otherwise it will be FALSE. Copy this formula down to all 

other cells in column K. 

In the example given above the value in cell K4 will be TRUE as the artists are the same. The value in 

cell K5 will be FALSE as the artists differ. 

Enter the following formula in cell L4: 

=(B4 - B3) = 1 

OR 

=B4 = (B3 + 1) 

The above formula tests whether the difference between the value in cell B4 and that in cell B3 is 1. If 

the difference is 1 the value in cell L4 will be TRUE otherwise it will be FALSE. Copy this formula down 

to all other cells in column L.  

In the example given above the value in cell L4 will be TRUE as the years differ by 1. The value in cell 
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L5 will be FALSE as the years differ by more than 1. 

Now that we’ve ascertained the logical values for the title, artist and years the AND function can be used 

to determine the overall logical value. Enter the following formula in cell M4: 

=AND(J4, K4, L4) 

Copy this formula down to all other cells in column M. 

In the example given above the values of J4, K4 and L4 are all TRUE so the value of cell M4 will be 

TRUE. This is correct as the song with title 3 sung by Britney Spears appeared in consecutive years, viz. 

2009 and 2010. The value in cell L5 will be FALSE as the values of J5, K5 and L5 are all FALSE. 

Now use the COUNTIF function to count the number of occurrences of the word TRUE in column M. 

Enter the following formula in cell M1603 

=COUNTIF(M3:M1602, "=TRUE") 

The cell will display the value 138 which is the number of titles by the same artist that appeared on the 

Billboard Hot 100 hits in consecutive years. 

 

Method 3: 

Use the same sorting procedure as given in Method 1. 

In cell J4 enter the following formula which is a combination of all the separate formulas used in Method 

2: 

=AND(D2=D3, E2=E3, B3=B2+1) 

Now count the number of times TRUE occurs in column J using the following formula: 

=COUNTIF(J3:J1602, "=TRUE") 

Or if you insert the formula in a different column you could use 

=COUNTIF(J:J, "=TRUE") 

8. The 'Title' of the song sometimes contains text in square brackets at the end of 

the title e.g. '[Remix]'. This is not part of the song title but a comment on that 

version of the song. If these 'comments' are removed, how many songs have a 

length of 32 characters? Give the number only, e.g. 131 

6 

It would probably be best to use an additional column (say column I) as follows: 

- If a song title contains additional comments enclosed in […] first strip the comment part out of the 

song title. This could be done using the FIND-function. However, if the character being looked for 

does not exist in the cell the FIND-function yields an error (#VALUE!). So it cannot be used by itself. 

Enter the following formula into cell I2: 

=IF(ISERROR(FIND("[", E2)), LEN(E2), LEN(LEFT(E2, FIND("[", E2))) - 2) 

The above formula checks to see whether the song title contains a “[“ using the FIND-function.  
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o If an error arises (i.e. the value would be #VALUE!), this would mean that there is no “[“ 

in the song title and so it would then determine the length of the song title (i.e. LEN(E2)). 

o If no error arises this would mean that the song title includes a “[“ and so we need to 

determine the length of the song without the part that extends from just before the “[“ to 

the end of the song title, i.e. LEN(E2), LEN(LEFT(E2, FIND("[", E2))) - 2 

 

- Copying this formula down to all the other cells in column I would give something similar to the 

following: 

Title 

 Hemorrhage (In My Hands) 24 

Hero 4 

Oochie Wally 12 

Most Girls 10 

Be Like That 12 

E.I. 4 

So Fresh, So Clean 18 

Dance With Me 13 

Method 1: 

Given the preparatory steps outlined above one could then insert the following formula in cell I1603 

=COUNTIF(I2:I1601, 32) 

Which would give a result of 6 

 

Method 2: 

Given the preparatory steps outlined above one could then sort the data on column I and simply count 

the number of times that the value 32 appears in the sorted list. 

Method 3: 

Given the preparatory steps outlined above one could turn on the filters and filter column I so that it only 

contains the value 32. Doing this would display a short list containing just 6 song titles. 

Title 

 Never Leave You (Uh Ooh, Uh Ooh) [Main] 32 

Single Ladies (Put A Ring On It) 32 

Try Sleeping With A Broken Heart 32 

Stronger (What Doesn't Kill You) 32 

The Fox (What Does the Fox Say?) 32 

Send My Love (To Your New Lover) 32 
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9. If all the songs played on the 31 December 2016 were played consecutively 

(one after each other) without any gaps between, how long, in minutes and 

seconds, will it take to play them all? Give your answer in the format specified 

mm:ss, e.g. 25:04 

74:17 

The length of each song is given in column F. It comprises a mixture of numerals and alphabetic 

characters (i.e. it is alphanumeric). A quick browse of the values will show that they all have the same 

format, viz. 2 digits followed by the letter “m”, followed by 2 digits and then the letter “s”, e.g. 04m23s.  

Because the data is consistent one can easily identify the minutes, possibly using the LEFT-function, 

and then the seconds, possibly using the MID-function. If the data is not consistent then one would need 

to use the FIND-function to get the numerals before the “m” and the numerals between the “m” and the 

“s”. 

Having obtained these separate values one then needs to convert the minutes into seconds by 

multiplying by 60 and then add this result to the number of seconds. Once this has been done for each 

of the songs played on 31 December 2016 the values need to be added together and then converted 

back into minutes and second by dividing by 60.  

Method 1: 

Turn on the filters and select only those songs that were last played on 31 December 2016. There are 

20 of them, the first of which is: 

Artist Title Length Date Last Played 

R. Kelly Ignition [Remix] 03m07s 2016/12/31 

Insert the following formula in column J to the right of the song: 

=LEFT(F300, 2)*60 + MID(F300, 4, 2) 

This should give a result of 187 (seconds). Copy this formula down to the other 19 songs in the list. Then 

add all the values together either by selecting them and looking at the sum in the taskbar or by using the 

SUM-function, e.g.  

=SUM(J300:J1601)  

You should get a result of 4457 (seconds). 

Now convert this value back to minutes and seconds using the INT-function, so something like the 

following in the cell just below where you used the SUM-function to get minutes: 

=INT(K300/60) 

And in the cell below the above cell something like the following: 

=K300 - (K394*60) 

OR 

=MOD(K300, 60) 
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If done correctly one should get the following answers: 

4457 Total number of seconds 

74 Minutes 

17 Seconds 

Showing that if played consecutively the 20 hit songs played on 31 December 2016 would take 74:17 

Method 2: 

Filters should be switched off and the data should be sorted according to the “Index” value (column A). 

Determine the length of all the songs (in seconds), using the method described above. Then in cell K2 

enter the following formula: 

=SUMIF(H2:H1601, "2016/12/31", I2:I1601) 

In cell K3 enter the following formula: 

=INT(J2/60) 

And in the cell below that enter the following formula: 

=J2-(J3*60) 

OR 

=MOD(J2, 60) 

If done correctly one should get the following answers: 

4457 Total number of seconds 

74 Minutes 

17 Seconds 

Showing that if played consecutively the 20 hit songs played on 31 December 2016 would take 74:17 
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C: DATABASE 

NB. Many of the database questions can also be solved by exporting the table as an Excel spreadsheet 

and then using spreadsheet functions. 

The Billboard Hot 100 is a chart that ranks the best-performing songs of the United States in any given 

year. Its data, published by Billboard magazine and compiled by Nielsen SoundScan, is based collectively 

on each song's weekly physical and digital sales, as well as airplay and streaming. The database 

'Hot100R2' contains some details of all the songs for the period 2001-2012. In the questions below a “solo 

performing artist” is an artist who performs by themselves and so only their name appears in the database 

as the artist. 

1. How many songs in the database were first released in 2000? Give the 

number only, e.g. 131 
38 

Method 1: 

Open the “HotHits” table in Datasheet view. Using the filter function in Access click on the arrowhead 

next to the “First_Release_Year” field, deselect “(Select All)” and select “2000”. After clicking on “OK” 

the data in the table will be filtered and only those records that were first released in 200 will be 

displayed. 

The number of records in the filtered data will be displayed in the taskbar, bottom-left of the screen. 

 
Clear the filters from the “First_Release_Year” field. 

Method 2: 

Select the “HotHits” table. Create a selection query by clicking on the 

“Query Wizard” button in the “Queries” group under the “Create” tab on 

the ribbon. In the “New Query” dialog box select “Simple Query Wizard” 

followed by “OK”.  

As you really only need to know the number of records that have “2000” 

in the “First_Release_Year” field double click on that field in the drop-

down menu and the field will be moved to the “Selected Fields” list. Click 

“Next”. In the next dialog box select “Modify the query design” followed 

by “Finish”. 

In order to select just those records that were first released in 2000 enter 

the value “2000” in the criteria box. If you now run the query it will 

produce a list of 38 records. 
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Method 3: 

Select the “HotHits” table. Create a query by clicking on the “Query Wizard” button in the “Queries” 

group under the “Create” tab on the ribbon. In the “New Query” dialog box select “Crosstab Query 

Wizard” followed by “OK”. 

In the “Crosstab Query Wizard” dialog make sure that “Table: HotHits” is selected and click “Next”. In the 

following dialog box double click on “First_Release_Year” and then click “Next”. In the next dialog box 

select any of the remaining fields, say “Genre”, followed by “Next”.  

The crosstab query wizard dialog box should look something like the following:  

 

Accept the options provided in the next dialog box by clicking on “Next” followed by “Finish”. A table 

similar to that shown below opens. This table shows the number of songs first released in each of the 

given years, So for example 38 songs were released in the year 2000. 
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2. How many songs categorised as 'pop' songs appear in the database? Give the 

number only, e.g. 131 
68 

Method 1: 

Open the “HotHits” table in datasheet view and click on the arrowhead next to the “Genre” field. You will 

note that the field values are numbers. 

Open the “Genre” table in datasheet view. For each of the “G-codes” there is a description of what the 

code means. For example, code 6 is country music while code 18 is disco music. In this table select the 

arrowhead next to the “Genre” field to open up a drop-down menu such as that below. 

 

Select “Text Filters” and “Contains” in the list of options. An input box opens – in this box type “pop” and 

click “OK”. A list of records with the word “pop” in the “Genre” field is displayed. Make a list of the code 

numbers, e.g. 15, 23, 26, 32, etc..Then close the “Genre” table. 

Now go back to the “HotHits” table and click on the arrowhead next to the “Genre” field. Deselect 

“(Select All)” and select only those numbers that you noted above. Some of the numbers might not 

appear in the table – do not be concerned. 

The filtered table now contains all the songs that are of the “Pop” genre. There are 68 of them. 

 

Clear the filter from the “Genre” field. 

Method 2: 

The database comprises 3 related tables, viz. HotHits, Genre and ArtistType. This means that a query 

can be created using data from any of the 3 tables. Without going into too much detail the following 

query can be created: 



 

 

 
 

21 

 

Note that the query contains field from the “HotHits” table and from the “Genre” table. When run this 

query will produce the following set of results where all the records contain the word “pop” in the “Genre” 

field: 

 

The “Total” row beneath the set of figures was obtained by clicking in the row under “SynthPop” and 

clicking on the “Totals” button in the “Records” group of the “Home” tab on the ribbon. Click in the field 

under the value 2 next to SynthPop and select “Sum” from the drop-down. 

Once again the result is 68 . 
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3. In which year did Alicia Keys appear three times as a solo performing artist? 

Give the year only, e.g. 2017 
2004 

Method 1: 

Open the “HotHits” table in datasheet view. Click on the arrowhead next to the “Artist” field and select 

“Text Filter” followed by “Equals”. “Equals” is being used here as the question refers to Alicia Keys as a 

solo artist, in other words only her name must appear in the artist field. If the wildcard character is used 

her name will appear along with the names of other artists. The following set of records is displayed: 

 

Note that only records with Alicia Keys as the artist appear. Now as the list is short one can either scan 

the “BillBoardHot100Year” field or sort according to the same field so that songs in the same year are 

next to each other. The scan will show that 2004 was Alicia Keys most successful year as she appeared 

3 times. In other years she appeared less than 3 times. 

Method 2: 

Select the “HotHits” table and create a simple query using the Simple Query Wizard. For the query 

select the “BillBoardHot100Year” field, the “Artist” field and any other field, e.g. the “Code” field. See 

below for the criteria to be used as well as the grouping. 



 

 

 
 

23 

 

When run the above query produces the following result: 

 

One can see again that 2004 is the year in which Alicia Keys appeared 3 times on the BillBoard Hot 100 

hits. 

Method 3: 

A crosstab query can also be created such as that shown below: 
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When run the above query produces the following output: 

 

The output again shows that 2004 was the most successful year. 

4. How many songs have the same name as the album on which they appear 

and are the first track on the album? Give the number only, e.g. 131 
17 

Method 1: 

Select the “HotHits” table and create a simple query using the query wizard. In the query use at least 

the “Title” and “Track” fields. You can add the “Album” field for verification purposes but it is not 

essential. In the criteria property for the  

- “Title” field insert the statement =[Album] as this will be used to check that only those songs that 

have a title name and album name the same are listed. 

- “Track” field insert the value “01” in order to ensure that only those songs that appeared on 

track 1 of the album are found. 
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The query would look something like the following: 

 
When run, the query produces a list of songs that satisfy the criteria.  

 

As the list is relatively short one can either count the number of songs or check the value in the taskbar. 

 
 

Method 2: 

Use method 1 as described above. 

Another way of determining how many songs meet the criteria is the following: 

- Click anywhere in the list of songs in datasheet view. 

- Then click on the “Totals” button in the “Records” group on the “Home” tab in the ribbon. A new 

row opens up below the list of songs and the word “Total” is automatically inserted. 
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- Click in the field to the right of the word “Totals” and you should note that a drop-down menu 

containing two options, viz. None and Count, is displayed. As the track number is a text field one 

can only count the number of tracks. If the field was say numeric then a number of different 

options would appear, e.g. sum, average, max, min, etc. For now click on the word “Count” and 

the count of the number of records in the list will be displayed. 

 

5. In how many of the country music songs that reached the Billboard Hot 100 in 

2008 did Taylor Swift appear? Give the number only, e.g. 131 
3 

Once again we’re faced with the situation that the genre of a song is given in the “HotHits” table by a 

number. We, therefore, have two possible options here: 

- Find out what code is given to the country music songs by checking for the value in the “Genre” 

table and then using this code in the “HotHits” table (Method 1), or 

- Using the fact that the tables are related via the genre code and creating a table that uses fields 

from both tables. (Method 2) 

Method 1: 

Open the “Genre” table in datasheet view. Click on the arrowhead next to the “Genre” field, then click on 

“Text Filters” and “Contains”. In the “Custom Filter” dialog box that opens insert the word “country”. A 

filtered list containing 3 records will be displayed. Note the code numbers, in this case 6, 20 and 67. 

Close the “Genre” table without saving. 

Open the “HotHits” table in datasheet view. Click on the arrowhead next to the “Genre” field, deselect 

“(Select All)” and then select the numbers you noted earlier, viz. 6, 20 and 67 (if they exist in the drop-

down). Then click “OK”. The original list of 1 200 songs has now been reduced to a list of just 100 songs 

that are of the “Country” genre. 

Now click on the arrowhead next to the “BillBoardHot100Year” field, deselect “(Select All)”, select 2008 

and then click “OK”. The list will be further reduced to just 4 songs of which Taylor Swift appears in 3 of 

them. 
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Method 2: 

Create a simple query using fields from the “HotHits” and “Genre” tables. The criteria to be used would 

be the year 2008 and the genre “country”. The query would look something like the following (note the 

wildcard character in the criteria for the “Genre” field. 

 

This query would produce exactly the same result as the previous method using the filters but without 

first having to find the genre codes. 

You could include an additional criteria in the “Artist” field, e.g. Like “*Taylor*”, as this would then only 

show those records that had the word “Taylor” in the “Artist” field. 

 

6. Some artists appear in the Billboard Hot 100 hits multiple times in a particular 

year. For example, Britney Spears has 4 songs in the 2009 Hot 100. Which 

male artist has appeared the most in any one year? Give the name exactly as it 

appears in the database. You may copy and paste. 

Justin Timberlake 

There are probably a number of different ways of arriving at a solution. These include using a:  

- Simple query and counting instances; 

- Pivot query; 

- Report with grouping and totals 
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In most instances it would be best to start with a simple query (MaleArtists) that selects only the 533 

male artists in the “HotHits” table, something like the following: 

 

Method 1: 

Using the MaleArtists query create a crosstab query that will have the artist as the column headers, the 

year as the row headers and will count the number of times the artist type occurs, see below: 

 

Clicking on “Next” and then “Finish” will produce the following output: 
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Right click on any of the values in the column headed “Total of ArtistType” and select “Sort Largest to 

Smallest” from the resulting drop-down menu. The list will then be sorted and will display as follows: 

 

If you now scan across the years for the top 5 artists you should notice that Justin Timberlake appears 5 

times in 2007. 

You could also use the filter functionality for each of the years by clicking on the arrowhead next to each 

year and sorting them in descending order. You’ll be looking for the highest number, which is 5 – this is 

found in 2007 when Justin Timberlake features at the top of the list. 

7. The database contains some errors as some songs appear to have reached 

the Hot 100 before they were actually released. According to the database how 

many song titles appeared on the Billboard Hot 100 before they were actually 

released? Give the number only, e.g. 131 

8 

Method 1: 

Create a simple query based on the “HotHits” table. Your query should include at least the 

“BillBoardHot100Year” field and the “First_Release_Year” field; it would be of interest to also include the 

artist and song title. The query could look similar to that sown below: 
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When run the query will produce a list of 8 songs shown below: 

 
 

Method 2: 

Create a crosstab query using the “HotHits” table. The row headings should be from the 

“BillBoardHot100Year” field and the column headings from the “First_Release_Year” field. The crosstab 

query wizard dialog box should look as follows: 
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Clicking “Next” and then “Finish” will produce a table such as that shown below (Note that the totals 

column has been hidden and the other columns have been narrowed so that more of the table is visible): 

 

You should note that  

- Most of the songs reached the Hot Hits in the year in which they were released (look at the cells 

where the Hot Hits year and release year are the same - two examples are highlighted in 

purple). These all fall on a diagonal (shown using a purple line); 

- 4 songs (highlighted in red) reached the Hot Hits in 2002 while 2 of them were only released in 

2003 and another 2 only released in 2005;  

- 3 songs (highlighted in green) reached the Hot Hits in 2003 while only be released in 2004 and 

2005;  

- 1 song reached the Hot Hits in 2010 while only being released in 2011. 

This makes a total of 8 songs that reached the Hot Hits before they were officially released – strange but 

true! 
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8. In which year did the most songs released in that year reach the Billboard Hot 

100 of the same year? Give the year only e.g. 2017 
2005 

Method 1: 

Create a crosstab query based on the “HotHits” table (see method 2 in the previous question). The 

crosstab query will produce a table such as that shown below: 

 

As pointed out in the previous question the cells that lie along the diagonal where the row containing the 

BillBoardHot100Year values and the column containing the values for the First_Release_Year intersect 

will be those songs that reached the Hot Hits in the year in which they were released. So look along the 

diagonal and find the largest value, which is 87 (highlighted). This happens in 2005. 

 

Method 2: 

Create a simple query based on the “HotHits” table. In the query use the “BillBoardHot100Year” and the 

“First_Release_Year” field. Insert a criterion in the appropriate place in the “BillBoardHot100Year” field. 

Your query should look similar to the following: 

 
Save the query and then create a report based on this query. The report format could look something 

like the following: 
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When viewed the report might produce something like the following: 

 

You should note that once again in 2005, 87 songs released in that year appeared on the Hot Hits 100. 

 

  



 

 

 
 

34 

9. Some artists have songs that appear in the Billboard Hot 100 hits over many 

years. For example, Rihanna has 16 songs over the period from 2005 to 2012. 

Which artist with the most songs appeared on the Billboard Hot 100 charts for 

the longest period of time - that is from the first time they appeared to the last 

time they appeared? Give the name exactly as it appears in the Database. You 

may copy and paste. 

Pink 

What one is endeavouring to determine with this question is who has the most hit songs extending over 

the longest period of time. 

Create a crosstab query based on the “HotHits” table. Use the “Artist” field as the row headers and the 

“BillBoardHot100Year” field as the column header. Count the number of occurrences of the “Code” 

field. The crosstab query wizard dialog box should look something like the following: 

 

After clicking “Next” and “Finish” you should obtain output similar to the following: 

 

Right click on the “Total Of Count” column header and select “Sort Largest to Smallest” from the 
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resulting drop-down menu. The output will now be sorted and appear something similar to the following: 

 

Note that the artists with the most songs appearing in the Hot Hits 100 appear at the top of the list. If you 

scan the row containing Rihanna you will note that she had her first hit in 2005 and continued having hits 

every year until 2012 (i.e. 16 hits over 8 years). The artist with the next most hits, viz. Kelly Clarkson, 

has hits stretching from 2002 to 2012 (i.e. 15 hits over 11 years). The next artist, viz. the Black Eyed 

Peas, have hits stretching from 2004 to 2011 (i.e. 15 hits over 8 years). 

If you look at the row containing Pink you will notice that they had 14 hits stretching from 2001 to 2012, a 

period of 12 years. Although there are other artists who have hits stretching over 12 years, e.g. Usher, 

Kenny Chesney and Toby Keith, Pink has the most hits. So the answer is Pink. 
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D: WEB QUEST 

A famous poet and playwright wrote the words 'If music be the food of love, play on'. 

Use any available search engine and the techniques that you know to answer the following questions. 

 

1. What is the name of the play from which the quote is taken? Give the answer 

exactly as it appears on the web, e.g. King Lear. You may copy and paste. 
Twelfth Night 

Open a Google search box and type in the words “If music be the food of love, play on”. 

One of the 72 600 000 results that are returned is the following: 

 
This shows that the words come from Shakespeare’s play “Twelfth Night”. 

NOTE: Using Edge and the Bing search facility yields a different set of only 26 500 000 results. 

2. If this playwright were still alive today (7 June 2017), how old, in completed 

years, would he be? Give the number only, e.g. 131 
453 

The first search revealed that the playwright was William Shakespeare. Enter “William Shakespeare” 

into Google’s search box. To further refine the search also enter “Date of birth”. One of the 1 550 000 

results is the following easily read synopsis: 

 
This clearly shows that William Shakespeare was born on 23 April 1564. A quick check in some of the 

other results will confirm this date of birth. 

To establish how old he would have been had he to have lived to 7 June 2017 one can use a number of 
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different methods. These include the following: 

- Subtract 1564 from 2017, this will give you 453. 

- Open Excel and enter the birth date and today’s date in adjacent cells and use the DATE-

functions to determine the age. 

NOTE: Using Edge and the Bing search facility yields a different set of only 26 500 000 results. 

3. What was the first name of his mother? Give the first name exactly as you find 

it on the web, e.g. Susan. You may copy and paste. 
Mary 

The result of the search conducted in the previous question shows that William Shakespeare’s mother’s 

name was Mary. 

 

4. To how many children did his wife give birth? Give the number only, e.g. 131  

The initial search information establishes that William Shakespeare’s wife’s name was Anne Hathaway. 

Clicking on the “Anne Hathaway” hyperlink in the search result  

 
and then following the Wikipedia link one establishes the following: 
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This search result shows that Anne Hathaway had only one spouse with whom she had 3 children. 

 

 

 


